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Fig. 1. Panel with an Exemplary Application

1.  APPLICATION

The operator’s panel allows the realization of all elementary control and 
programming functions, control visualization , management and control 
of production and measuring processes. The panel creates the gra-
phical interface between the operator and the machine enabling the 
data introduction and device control by means of the touch screen. The 
panel is adapted to co-operate with PLC controllers, controllers, and 
with other devices.
The operator’s panel gives the possibility of a simple affect on the tech-
nological process run, e.g. through the selection of the prepared set of 
parameters settings through giving values from the keyboard, genera-
tion  of alarms and warnings, and creation of reports including substan-
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tial changes of technological process parameters in time, e.g. for the 
manufacturer department of the production quality management.
Advanced visualization functions, as animation, trend indications and 
measuring functions as canvassing, data storage and similar, increase 
considerably the panel efficiency, facilitate the operator work and opti-
mize the control process. The advanced visualization and the rich set of 
functions contribute also to a minimalization of service errors, what has 
a direct influence on the product quality.
The panel control algorithm is created on a PC computer for specific 
solutions of control systems, and next downloaded to the standard pa-
nel through a serial link.
The very efficient programming tool Panel Master serves to design the 
control algorithm, this no requires the knowledge of any programming 
language, operating on any personal computer under the control of 
WINDOWS 2000/XP/ VISTA/7 systems. 
The tool software is equipped with communication drivers to many de-
vices and with a rich library of functional modules, what enables in an 
easy way the panel function configuration, error diagnosis, design of 
dialogues with the user.
The construction of control structures consists on the placement of 	
ready library objects on project sheets and parameter setups of these 
objects acc. to requirements.

2.  METER SET

The set is composed of:
- operator’s panel..........................................1 pc
- clamps to fix in the panel............................4 pcs/8 pcs*
- service manual............................................1 pc
- guarantee card...........................................1 pc
- installation plate..........................................1 pc
* for MT084 and MT104
When unpacking the operator’s panel, please check whether the type 
and execution code on the data plate correspond to the order.
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4.  PANEL FITTING

4.1. Overal Dimensions and Fixing Way
The panel is adapted to be fixed in a board acc. to the fig. 2 and 3.
Housing dimensions:
- MT035	 130  106.2  36 mm 
- MT058	 186.5  145.5  42 mm
- MT084	 232.5  175.8  50 mm
- MT104	 300  225  50 mm.

3.  BASIC REQUIREMENTS  AND OPERATIONAL 	  	
     SAFETY

In the safety service scope, the operator’s panel meets 	
the requirements of the EN 61010-1 standard.
Observations Concerning the Operational Safety:
l All operations concerning transport, installation, and commissioning 
as well as maintenance, must be carried out by qualified, skilled per-
sonnel, and national regulations for the prevention of accidents must 
be observed.
l Before switching the panel on, one must check the correctness of 
connection to the network.
l Before removing the panel housing, one must  switch the supply off 
and disconnect measuring circuits.
l The removal of the panel housing during the guarantee contract 	
period may cause its  cancellation.
l The panel is destined to be installed and used in industrial electro-
magnetic environment conditions.
l One must remember that in the building installation a switch or a 	
circuit-breaker should be installed. This switch should be located near 
the device, easy accessible by  the operator, and suitably marked.
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Fig. 2. Overall Dimensions of the MT035 Panel

One must prepare a hole in the board with dimensions acc. to fig. 2...5. 
The material thickness which the board is made of should not exceed 
6 mm.
The panel must be introduced from the board front with disconnected 
supply voltage. After the panel insertion into the cut-out, one must fix it 
by means of four clamps at the rear side of the board acc. to the fig. 6.
Clamps should not be screwed too tightly or unequally because this 
may cause the damage of the touch screen.
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Fig.6. Panel Fixing
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4.2. Description of Connections

COM2
RS422/RS485

Fig. 7. Supply and Communication Ports of  the MT035 Panel Type

Supply  
24 V d.c.

COM1
RS232/ 

RS422/RS485
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In order to supply the HMI panel, one must connect 24 V d.c. ±10% 
to the input. COM1 and COM 2 communication ports can be used as 
RS232, RS422 and RS485 serial ports. If the need arises, one must 
prepare a suitable wire for the connection to ports.

Serial port COM1 in the panel  – female connector DB9-9P.
Pin definition:

Pin Function Pin Function
1 RS422 TX+ i RS485 +(A) 6 RS422 TX- i RS485 –(B)
2 RS232 RXD 7 RS232 RTS
3 RS232 TXD 8 RS232 CTS
4 RS422 RX+ 9 RS422 RX-
5 GND

Serial port COM2 in the panel – 4 (5) pin connector (RS422 and RS485)

422 TX+ RX+ RX- TX- SG

485 +(A)                    -(B)

Serial port COM2 in the panel – male connector DB9-9P (only for 
MT058, MT084 and MT104).
Pin definition:

Pin Function Pin Function
1 RS485 +(A) 6 RS485 –(B)
2 RS232 RXD 7 RS232 RTS
3 RS232 TXD 8 RS232 CTS
4 9
5 GND

Serial port COM3 in the panel – 6 pin connector (RS232) (only MT084 
and MT104).

5V CTS RTS TXD RXD SG
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Fig. 10. Starting Screen: Panel Setup

5.  PANEL SETTINGS

After switching the supply on, the panel displays the starting screen 
Panel Setup presented on the fig. 10. Choosing the General option, 
one can check or set common panel parameters, such as: battery 
checking, time of the screen killer, display mode of the starting screen, 
communication settings, language, brightness level of the LCD screen, 
and the IP address (if the panel is equipped with the Ethernet port).

Choosing the touch panel option, one can adjust the working dimen-
sion of the touch screen but, one must carry out  this function only in 
case of necessity.
The Real Time Clock option allows to setup the Real time clock, howe-
ver link1, link2 option allow to setup communication ports parameters 
suitably as  COM1 and COM2.
Pressing the Copy to option, one can copy the Project into another 
panel.
To cross to the carry out application, one must press the Run button.
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In  order to start the application with omission of the configuration menu 
(Setup Menu), every time after switching the panel supply voltage, one 
must carry out below mentionned operations.

Step 1: Before switching the supply voltage, press the touch screen in 
the upper left corner, next switch the HMI panel during ca 3-5 sec. hol-
ding down the screen pressure (Fig. 11) till the hearing of a short sound 
(Beep). The BIOS mode will be started.

5.1. Automatic Starting of Applications after 			
       Switching the Supply on.

Fig.11. Entrance in BIOS Mode at Setup of the Configuration 
(Setup Menu)
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Step 2: Following options are available in BIOS mode:
l updating of the operating system (Update OS)
l entrance in the configuration menu (Panel OS)
l selection of the start screen after switching the voltage supply on:
	 o   pressing Run AP – automatic start of the application
	 o   pressing Panel Setup – start of the configuration menu screen 
l test of the HMI panel (Test): LCD, touch screen, clock and internal 		
     memory.

Fig. 12 Start in the Run AP Mode	

Fig. 13 Start in the Panel Setup Mode

Acceptation of changes by the OK button. Exit from BIOS mode after 
pressing the Exit button.
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Step 3:	 If the application (Run AP) has been set as the start screen, 
and we would restore the start of the configuration menu (Setup Menu), 
one must hold down the upper right screen corner (Fig. 14) during ca 
3-5 sec. during switching the supply voltage on. After hearing a short 
sound (Beep), the configuration menu (Setup Menu) appears.
A renewed switching of the supply on will cause the application start.

Fig. 14 Single Calling of the Configuration Menu (Setup Menu) when 
Setting the Automatic Application Start (Run AP).
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6.  PANEL MASTER SOFTWARE  
INSTALLATION

6.1. Hardware Requirements
Before the installation of the Panel Master software, one must check if 
the computer fulfils following hardware requirements:
l	 at least, a Pentium III processor,
l	 at least, 100 MB of access availability on the hard disk,
l	 at least, 64 MB of system memory,
l	 serial port or LAN necessary for the communication with the 	
	 operator’s panel in order to transmit files to the panel,
l	 CD installation disk , one can also collect the installation program 	
	 from the Internet page http://www.lumel.com.pl, 
l	 Windows 2000/ XP/ VISTA operating system (system of the Unicode text).

6.2. Installation
l	 on must close all programs before beginning the installation,
l	 click twice the setup.exe icone from the installation CD disk to start 	
	 the installation program,
l	 proceed acc. to instructions of the installation program,
l	 default program catalogue:C:\Program Files\PanelMaster

7. DESCRIPTION OF SELECTED PANEL  
     MASTER PROGRAM FUNCTIONS

7.1. Loading in the Existing Project
To load in the existing project, one must choose the Open... option 

from the File menu or click the  icone on the tool bar. The win-
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Fig. 15.  Loading the Project from the File

7.2. Creating a New project

To create a new Project, one must choose the New... option from the 

File menu, or click the  icone on the tool bar. The window (fig. 16) 

will be displayed. One must give the file name of the new project and 

the file situation and next, click the Further> button.

dow of project files will be displayed (fig. 15). One must choose the 
existing project xx.pmj and next click the Open buton.
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Fig. 16. Creation of a New Project – Project Name

Fig. 17.  Creation of a New Project – Panel Type

In the succeeding window (fig. 17), one must choose the panel type:
	 MT035-TST(Color)
	 MT058-TST(Color),
	 MT058-TNT(Color/Ethernet),
	 MT084-TNT(Ethernet),
	 MT104-TNT(Ethernet).
and write in the panel name (Panel_1 by default), and next click the 
Further> button.
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The succeeding window (fig.18) will be displayed in which, one must 
define connection parameters with the co-operating device.

Fig. 18.  Parameters of Link Connection

Link Name: connection name, e.g. RE20-RS; when a transmission 
error occurs, the connection name will be displayed in the error com-
munication window.

Link Type: the Direct Link (COM) connection type means the direct 
connection of the COM1 serial port with the device serial port. If the 
panel and the connected device are equipped with the Ethernet port, 
one can choose the Direct Link (Ethernet) connection type.
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Link Port: defines panel ports acc. to the chosen operator’s panel 
type; one must choose the panel port, which the device is connected 
to.

Device/Server: from the developed list, one must choose the suitable 
communication driver type for the connected device. 

In the presented above example, the RE20 controller with Modbus pro-
tocol in RTU mode is connected to the RS-485 serial port of the panel 
(COM1).
The Project tree appears in the Project Manager window, and the win-
dow of the projected panel Screen 1, on the Panel 1 tag.
The simple method of the screen edition proceeds in three steps pre-
sented below: 

1.	Click the icon of the chosen object on the tool bar.

2.	Put the object in the suitable place on the projected screen. 	
	 Adjust the object frame dimensions. 

3.	Click the right mouse key to display the Object Properties 	
	 dialogue and set object properties, i.e. frame style, font, data 	
	 type, address, function, etc.

Example of a project to display the set value from the RE20 controller 
on the screen:

1.	Click the Numeric Display icon on the tool bar or choose the 	
	 Numeric Display option from the Object menu.

2.	Place the mouse cursor in the chosen place in the Screen 1 	
	 and click the left mouse key. A rectangle with a numerical value 	
	 appears on the screen. Readjust the rectangle dimensions to 	
	 own needs.

3.	Choose the Object Properties option by the right mouse key. 	
	 The dialogue of Numeric Display object properties presented 	
	 on the fig. 19 will be displayed.
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Fig. 19.  Properties of the Numeric Display

Establish the shape and the colour of the frame with the numerical va-
lue, mark eventually the external label value description. Then, an extra 
External Label tag appears on which, one can write in the value des-
cription text and set the font and colour. 

Cancel HelpOK
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One must choose the type of downloaded data by the device in the 
Data Type field. For the RE20 controller there is a 16-bit Signed Int. 
Additionally, one can set a complete number of digits of the displayed 
value (Total Digits), the number of digits after the decimal point (Fractio-
nal Digits), the font and colour.

In the Monitor Address field, one must choose the icon beside the  
field. The dialogue presented on the fig. 20 appears in which, one must 
give the data source.

Fig. 20. Source Definition of Numerical Field Data

In the upper selection field, one must choose the name of the Link con-
nection, which data will originate from (RE20-RS here). The download 
frame is defined below: in turn, the address in the Modbus network, va-
lue type (W dla RE20) and the register number for the controller (4005 
corresponds to the SP set value). Settings must be accepted by the 
ENT button.
To terminate the definition of the Numeric Display object, press the OK 
button.
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Fig. 21.  Data Type: Selection of the Data Type

Choice of the floating point value.
One must choose the type of downloaded data by the device in the Data 
Type field. For Lumel S.A. devices, that is the 32-bit Floating Point.
One can set additionally the complete number of digits of the displayed  	
quantity (Total Digits), the number of digits after the decimal point 
(Fractional Digits), the font and colour.
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Fig. 22.
Establishment of the Address 
of the Float Point Type (for the 
Register Address 7000) for 
the Device nr 1 in the Modbus 
network.

Fig. 23. Helping Window Presenting Possible Types of Variables.
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7.3. Addition of the Modbus TCP/IP connection

Fig. 24. Addition of a New Connection to the „Link” List.
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Link Number: the program enables to set, up to 4 independent Ethernet 
connections using the Modus TCP/IP protocol.

Link Name: name identifying the connection; when a transmission error 
occurs, the connection name will be displayed in the error communi-
cation window.

Link Type: one must choose the Direct Link (Ethernet).

Link Port: defines panel ports acc. to the chosen operator panel type; 
one must choose the panel port, which the device is connected to in the 
case of TCP/IP – Ethernet.

Device/Server: from the developed list, one must choose the type of the 
suitable communication driver for the connected device.

Fig. 25.  Setting of  ‘General Properties”.

OK Cancel Help
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Fig. 26.  „Parameters Properties” Settings Establish Parameters of the 
TCP Connection.

IP Address:	 device address – server in the Ethernet network,

Port:	 Number of the TCP Port on which the data Exchange 	
	 will be carried out.

Node Address:	device address – server. Parameter used	
	 when applying devices of Getwey 	
	 Modbus TCP type,

Retry Count:	 number of query repetitions in case when a 	
	 transmission error appears.

Address: device address – server in the Ethernet network,

OK Cancel Help
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Fig. 27. Correctly Added TCP Connection: TCP MODBUS
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Fig. 28.  Configuration Window of the variable displayed on the panel.

OK Cancel Help
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To choose the MODBUS connection, one must choose the configura-
tion window of the variable displayed on the panel (calculator icon).

Fig.29.  Selection of the TCP MODBUS Connection

Fig. 30.  Correctly Configured Window of the 32-bit Variable of Float 
Type for the TCP MODBUS Connection

Such prepared project, can be stored to the file (menu File->Save), and 
next loaded into the panel.
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7.4. Loading the Project into the Panel
To load the project into the panel, one must choose the Transfer Data 

to Panel... option or click the   icon on the tool bar. The window 
presented on the fig. 31 will be displayed. 

Fig. 31  Loading the Project into the Panel.

Communication port (COM1)
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Fig. 32.  Loading the Project into the Panel when Connecting in the 
Ethernet  Network.

Communication port (COM1)
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Before loading the project into the panel, one must select the commu-
nication port (COM1...COM32) and the baud rate (Baudrate) when se-
lecting the transmission through COM. However, if selecting the Ethernet 
option, one must give the IP address.
After pressing the Start button, the project will be compiled, and next 
transmitted to the panel.
If the loading does not succeed, one must check if the COM port is not 
occupied by other devices or if the panel if correctly switched to the 
local network on.

The “Recommended” option records main files of the project.

Fig. 33. The Option “All except OS0” loads all project files without 
system Files.
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Fig. 34. The option “All” loads all project files with system files. 	
The option is required in case of an erroneous  

programming of the panel, or a transmission break during the configu-
ration loading.
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8.  TECHNICAL DATA

Dysplay Type	 TFT LCD 256 colours, with touch 	
	 panel (MT035, MT058)

	 TFT LCD 65535 colours with touch 	
	 panel (MT084, MT104)

Display Size:
- MT035	 3.5”  (diagonal)
- MT058	 5.7”  (diagonal)	 	
- MT084	 8.4”  (diagonal)	 	
- MT104	 10.4” (diagonal)

Screen Resolution	 320 ´ 240 pixels (for MT035, 		
	 MT058)

	 800 ´ 600 pixels (for MT084, MT104)

Back Light of the Screen	 LED, life time 50 000 godz.

Supply	 24 V d.c. ±10%;

Power Consumption:
- MT058, MT084, MT104	 20 W
- MT035	 6 W

CPU	 RISC ARM 32 Bit CPU

Flash Memory	 4 MB, 16 MB (for MT084, MT104)

Operating System Memory	 64 MB for MT084, MT104
	 2 MB (MT058)
	 1 MB (MT035)

Battery Backed Memory	 128 KB...1 MB (chosen in the 	
	 program option)
Communication Ports:
- COM1/9 pin	 RS232/RS422/RS485
- COM2/9 pin 	 RS232/RS485 (MT058, MT084, MT104)
- COM2/Terminal 5 pin 	 RS422/RS485 (MT035, MT058, 	
	 MT084, MT104)
- COM3/Terminal 6 pin 	 RS232 (MT084 and MT104)	
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- network	 Ethernet (TNT)

- 2 x USB	 Host v2.0  (MT084 and MT104)	
- 1 x USB 	 Host v1.1 (frontal panel) only MT104

Protection Level from Panel  
frontal Side	 IP 65

Operating Temperature	 0... 50°C

Storage temperature	 -20... 60°C

Ambient Humidity	 20... 90% RH (non-condensing)

Vibration Endurance	 amplitude 0.5 mm, 10...55 Hz, 	
	 2 hours in X, Y, Z axis directions

Shock endurance	 10 G, 11 ms three times in each 	
	 X, Y, Z direction
Weight:
- MT035	 0.3 kg
- MT058	 0.85 kg	 	
- MT084	 0.9 kg	 	
- MT104	 1.6 kg

STANDARDS FULFILLED BY THE PANEL
Electromagnetic  
Compatibility:

- noise immunity	 EN 61000-6-2

- noise emissions	 EN 61000-6-4



41

1) - numbering will be established by the manufacturer

9.  ORDER CODES

Operator’s Panel of MT Type- XXX-XXX XX X
Type:                              
3.5’’ 035-TST
5.7’’ 058-TST
5.7’’ Ethernet 058-TNT
8.4’’ Ethernet 084-TNT
10.4’’ Ethernet 104-TNT
Kind of Execution:
standard 00
custom-made1) XX
Acceptance tests:
without an extra quality inspection 8
with an extra quality inspection certificate 7
acc. customer’s agreement1) X
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10.  Maintenance and Guarantee

This operator’s panel does not require any periodical maintenance.
In case of some incorrect unit operations:

From the Shipping Date, During the Period Given in the Annexed 
Guarantee Card

One should take the instrument down from the installation and return it 
to the Manufacturer’s Quality Control Dept.
If the instrument has been used in compliance with the instructions, the 
Manufacturer guarantees to repair it free of charge.

After the Guarantee Period:

One should turn over the instrument to repair in a certified service workshop.
The disassembling of the housing causes the cancellation of the gran-
ted guarantee.

The Manufacturer’s policy is one of continuous improvement 
and we reserve the right to make changes in design and speci-
fications of any products as engineering advances or necessi-
ty requires and revise the above specification without notice.
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SALES PROGRAM
	DIGITAL and BARGRAPH PANEL METERS
	MEASURING TRANSDUCERS
	ANALOG PANEL METERS (DIN INSTRUMENTS)
	 INDUSTRIAL PROCESS and POWER CONTROLLERS
	CHART and PAPERLESS RECORDERS
	1-PHASE and 3-PHASE WATT-HOUR METERS
	LARGE SIZE DISPLAY PANELS
	ELEMENTS OF INTEGRATION SYSTEMS
	ACCESSORIES for MEASURING INSTRUMENTS (SHUNTS and CURRENT 	 	
	 TRANSFORMERS)
	CUSTOM-MADE PRODUCTS ACCORDING CUSTOMER’S REQUIREMENTS

WE ALSO OFFER OUR SERVICES IN THE PRODUCTION OF:
	ALUMINIUM ALLOY PRESSURE CASTINGS
	PRECISION ENGINEERING and THERMOPLASTICS PARTS
	SUBCONTRACTING of ELECTRONIC DEVICES (SMT)
	PRESSURE CASTINGS and OTHER TOOLS

Lubuskie Zak³ady Aparatów  Elektrycznych LUMEL S.A.
ul. Sulechowska 1, 65-022 Zielona Góra, Poland

Tel.: (48-68) 329 51 00 (exchange)
Fax: (48-68) 329 51 01
e-mail:lumel@lumel.com.pl
http://www.lumel.com.pl 

Export Department:
Tel.: (48-68) 329 53 02
Fax: (48-68) 325 40 91
e-mail: export@lumel.com.pl 

MEASUREMENT
CONTROL
RECORDING

QUALITY PROCEDURES:
According to ISO 9001 and ISO 14001 international requirements.
All our instruments have CE mark.
For more information, please write to or phone our Export Department
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